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AT-GPIB/TNT

1. Configure the AT-GPIB/TNT Base I/O Address.

2. Configure the AT-GPIB/TNT Interrupt Line (IRQ).

3. Configure the AT-GPIB/TNT DMA Channel.

After you finish these steps, you are ready to Install the AT-GPIB/TNT.
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Figure 1.  AT-GPIB/TNT Parts Locator Diagram
View Parts Locator Diagram

1 Product Name, Revision Letter, 
and Assembly Letter

2 Serial Number

3 Base I/O Address
4 Shield Ground

5 Interrupt Line (IRQ)
6 DMA Channel

1 32

6 45
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Configure the AT-GPIB/TNT Base I/O Address
Click the base I/O address assigned to your AT-GPIB/TNT from the following list, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your AT-GPIB/TNT, click here to Determine 
Assigned Resources.

100 200 300

120 220 320

140 240 340

160 260 360

180 280 380

1A0 2A0 3A0

1C0 2C0 (Default) 3C0

1E0 2E0 3E0
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Table 1.  Possible Base I/O Address Switch Settings for AT-GPIB/TNT

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

100 120

140 160

180 1A0

1C0 1E0

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

View Parts 
Locator 

Diagram
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200 220

240 260

280 2A0

2C0
(Default)

2E0

Table 1.  Possible Base I/O Address Switch Settings for AT-GPIB/TNT (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

A9O
F

F

A8

A7

A6

A5

A9O
F

F
A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

View Parts 
Locator 

Diagram
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300 320

340 360

380 3A0

3C0 3E0

Table 1.  Possible Base I/O Address Switch Settings for AT-GPIB/TNT (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

A9O
F

F

A8

A7

A6

A5

A9O
F

F
A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

View Parts 
Locator 

Diagram
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Configure the AT-GPIB/TNT Interrupt Line (IRQ)
Change the jumper settings to match the interrupt line (IRQ) assigned to your board. By default, 
the AT-GPIB/TNT is configured to use interrupt line (IRQ) 11.

If you do not know what resources were assigned to your AT-GPIB/TNT, click here to Determine 
Assigned Resources.

Table 2.  AT-GPIB/TNT Interrupt Line Configurations

Interrupt Line (IRQ) Interrupt Jumper Setting

10, 11, 12, 14, or 15
(IRQ 11 is shown)

3, 4, 5, 6, 7, or 9
(IRQ 5 is shown)

No Interrupt Line (IRQ)

D
R

Q
5

D
R

Q
7

D
A

C
K

7

D
R

Q
6

D
A

C
K

6

D
A

C
K

5

IRQ

15 14 12 11 10

Used to
Select
DMA

=

3 4 5 6 7 9

IR
Q

3

IR
Q

9

3 4 5 6 7 9

IR
Q

3

IR
Q

9

View Parts 
Locator 

Diagram
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Configure the AT-GPIB/TNT DMA Channel
Change the jumper settings to match the DMA channel assigned to your board. You must set both 
the DMA Acknowledge and DMA Request lines. By default, the AT-GPIB/TNT is configured to use 
DMA channel 5.

If you do not know what resources were assigned to your AT-GPIB/TNT, click here to Determine 
Assigned Resources.

Table 3.  AT-GPIB/TNT DMA Channel Settings

DMA Channel DMA Jumpers

5, 6, or 7
(DMA 7 is shown)

No DMA Channel

D
R

Q
5

D
R

Q
7

D
A

C
K

7

D
R

Q
6

D
A

C
K

6

D
A

C
K

5

IRQ

15 14 12 11 10

Used to
Select
IRQ

=

D
R

Q
5

D
R

Q
7

D
A

C
K

7

D
R

Q
6

D
A

C
K

6

D
A

C
K

5

IRQ

15 14 12 11 10

Used to
Select
IRQ

=

View Parts 
Locator 

Diagram
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Set the AT-GPIB/TNT Shield Ground Configuration
The AT-GPIB/TNT is set at the factory with the jumper in place to connect the logic ground of the 
AT-GPIB/TNT to its shield ground. This configuration minimizes EMI emissions.

Caution The AT-GPIB/TNT was tested for compliance with FCC standards with the shield ground connected 
to logic ground. Removing the jumper might cause EMI emissions to exceed any or all of the 
applicable standards.

Most users do not need to change the shield ground configuration. If you need to disconnect logic 
ground from shield ground, complete the following steps:

1. Locate the shield ground jumper W3 on the AT-GPIB/TNT. (View the AT-GPIB/TNT Parts 
Locator Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in Figure 2.

Figure 2.  AT-GPIB/TNT Ground Configuration Jumper Settings

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W3

W3
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Install the AT-GPIB/TNT
PRINT THIS TOPIC! 
Your computer needs to be off while you install your AT-GPIB/TNT. To print this topic, select 
File»Print, select the Pages radio button, and print pages 11–12.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

Complete the following steps to install your AT-GPIB/TNT.

1. Make sure that your board is configured to match the assigned resources. If you are not sure, 
view the instructions for configuring the AT-GPIB/TNT.

2. Shut down Windows and power off your computer. Keep the computer plugged in so that it 
remains grounded while you install the AT-GPIB/TNT.

3. Remove the top cover (or other access panels) to gain access to the computer expansion slots.

4. Find an unused expansion slot in your computer. The AT-GPIB/TNT requires a 16-bit ISA 
expansion slot.

5. Remove the corresponding slot cover on the back panel of the computer.
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6. Insert the AT-GPIB/TNT into the slot with the GPIB connector sticking out of the opening on 
the back panel, as shown in Figure 3. It might be a tight fit, but do not force the board into 
place.

Figure 3.  Installing the AT-GPIB/TNT

7. Screw the mounting bracket of the AT-GPIB/TNT to the back panel rail of the computer.

8. Replace the top cover (or the access panel to the expansion slot).

9. Power on your computer and start Windows.

The AT-GPIB/TNT hardware installation is now complete.
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GPIB-PCII/IIA

1. Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCII Mode).

2. Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCII Mode).

3. Configure the GPIB-PCII/IIA DMA Channel.

After you finish these steps, you are ready to Install the GPIB-PCII/IIA.

National Instruments recommends that you configure the board in PCII mode, using the previous 
steps. If you want to use your GPIB-PCII/IIA in PCIIA mode, click here to Configure the GPIB-PCII/IIA 
in GPIB-PCIIA Mode.
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Figure 4.  GPIB-PCII/IIA Parts Locator Diagram
View Parts Locator Diagram

1 Product Name
2 Assembly Number, Serial Number, 

and Revision Number

3 Base I/O Address
4 Interrupt Line (IRQ)

5 DMA Channel
6 Shield Ground



1

2

3

4

5 6
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Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCII Mode)

Click the base I/O address assigned to your GPIB-PCII/IIA from the following list, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

100 180 200 280 300 380

108 188 208 288 308 388

110 190 210 290 310 390

118 198 218 298 318 398

120 1A0 220 2A0 320 3A0

128 1A8 228 2A8 328 3A8

130 1B0 230 2B0 330 3B0

138 1B8 238 2B8 (Default) 338 3B8

140 1C0 240 2C0 340 3C0

148 1C8 248 2C8 348 3C8

150 1D0 250 2D0 350 3D0

158 1D8 258 2D8 358 3D8

160 1E0 260 2E0 360 3E0

168 1E8 268 2E8 368 3E8

170 1F0 270 2F0 370 3F0

178 1F8 278 2F8 378 3F8
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Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

100 108

110 118

120 128

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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130 138

140 148

150 158

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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160 168

170 178

180 188

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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190 198

1A0 1A8

1B0 1B8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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1C0 1C8

1D0 1D8

1E0 1E8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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1F0 1F8

200 208

210 218

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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220 228

230 238

240 248

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3
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250 258

260 268

270 278

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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280 288

290 298

2A0 2A8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
F

F

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 
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2B0
2B8

(Default)

2C0 2C8

2D0 2D8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 
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2E0 2E8

2F0 2F8

300 308

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 
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310 318

320 328

330 338

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 
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340 348

350 358

360 368

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 
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370 378

380 388

390 398

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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3A0 3A8

3B0 3B8

3C0 3C8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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3D0 3D8

3E0 3E8

3F0 3F8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCII Mode)
Change the jumper settings to match the interrupt line (IRQ) assigned to your board. By default, 
the GPIB-PCII/IIA is configured to use interrupt line (IRQ) 7.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

Table 5.  GPIB-PCII Interrupt Line Configurations

Interrupt Line (IRQ) Interrupt Jumper Setting

2, 3, 4, 5, 6, 7
(IRQ 7 is shown)

No Interrupt Line (IRQ)

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

View Parts 
Locator 

Diagram
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Configure the GPIB-PCII/IIA DMA Channel
Change the jumper settings to match the DMA channel assigned to your board. You must set both 
the DMA Acknowledge and DMA Request lines. By default, the GPIB-PCII/IIA is configured to use 
DMA channel 1.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources. 

Table 6.  GPIB-PCII/IIA DMA Channel Settings

DMA Channel DMA Jumpers

1, 2, or 3
(DMA 3 is shown)

No DMA

D
R

Q
1

D
A

C
K

1

D
R

Q
2

D
A

C
K

2

D
R

Q
3

D
A

C
K

3

D
R

Q
1

D
A

C
K

1

D
R

Q
2

D
A

C
K

2

D
R

Q
3

D
A

C
K

3

View Parts 
Locator 

Diagram
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Set the GPIB-PCII/IIA Shield Ground Configuration
The GPIB-PCII/IIA is set at the factory with the jumper in place to connect the logic ground of the 
GPIB-PCII/IIA to its shield ground. This configuration minimizes EMI emissions.

Caution The GPIB-PCII/IIA was tested for compliance with FCC and CE standards with the shield ground 
connected to logic ground. Removing the jumper might cause EMI emissions to exceed any or all 
of the applicable standards. 

Most users do not need to change the shield ground configuration. If you need to disconnect logic 
ground from shield ground, complete the following steps:

1. Locate the shield ground jumper W1 on the GPIB-PCII/IIA. (View the GPIB-PCII/IIA Parts 
Locator Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in Figure 5.

Figure 5.  GPIB-PCII/IIA Ground Configuration Jumper Settings

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W1

W1
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Install the GPIB-PCII/IIA
PRINT THIS TOPIC!
Your computer needs to be off while you install your GPIB-PCII/IIA. To print this topic, select 
File»Print, select the Pages radio button, and print pages 35–36.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

Complete the following steps to install the GPIB-PCII/IIA.

1. Make sure that your board is configured to match the assigned resources. If you are not sure, 
view the instructions for configuring the GPIB-PCII/IIA.

2. Shut down Windows and power off your computer. Keep the computer plugged in so that it 
remains grounded while you install the GPIB-PCII/IIA.

3. Remove the top cover (or other access panels) to gain access to the computer expansion slots.

4. Find an unused expansion slot in your computer.

5. Remove the corresponding slot cover on the back panel of the computer.
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6. Insert the GPIB-PCII/IIA into the slot with the GPIB connector sticking out of the opening on 
the back panel, as shown in Figure 6. It might be a tight fit, but do not force the board 
into place.

Figure 6.  Installing the GPIB-PCII/IIA

7. Screw the mounting bracket of the GPIB-PCII/IIA to the back panel rail of the computer.

8. Replace the top cover (or the access panel to the expansion slot).

9. Power on your computer and start Windows.

The GPIB-PCII/IIA hardware installation is now complete.
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Configure the GPIB-PCII/IIA in GPIB-PCIIA Mode
This section describes how to configure your GPIB-PCII/IIA board for use in GPIB-PCIIA mode.

Note National Instruments recommends that you configure your GPIB-PCII/IIA in PCII mode. The 
NI-488.2 software allows you to install your GPIB-PCII/IIA board for use in GPIB-PCII or GPIB-PCIIA 
mode. The two modes use different I/O addresses and interrupt schemes. However, you should be 
aware of a potential problem with the Windows Device Manager when using your board in 
GPIB-PCIIA mode under Windows. The Device Manager does not reliably report base address 
conflicts involving the GPIB-PCII/IIA in GPIB-PCIIA mode. Additionally, the Device Manager fails to 
display all of the I/O addresses used by the GPIB-PCII/IIA in GPIB-PCIIA mode. Therefore, a base 
address conflict may go unchecked when using your board in GPIB-PCIIA mode. Base address 
conflicts can cause your computer to hang or otherwise behave unreliably. Therefore, it is safest 
to use the board only in GPIB-PCII mode, not in GPIB-PCIIA mode. 

1. Configure GPIB-PCIIA and 7210 Modes.

2. Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCIIA Mode).

3. Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCIIA Mode).

4. Configure the GPIB-PCII/IIA DMA Channel.

After you finish these steps, you are ready to Install the GPIB-PCII/IIA.
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Configure GPIB-PCIIA and 7210 Modes
The GPIB-PCII/IIA comes already configured to run in PCII and 7210 modes. To change the 
configuration to PCIIA mode, complete the following steps:

1. Examine switch 9 in switch block U2. (Click here to view the GPIB-PCII/IIA Parts Locator 
Diagram.) Press switch 9 down on the side labeled PCIIA, as shown in Figure 7.

Figure 7.  GPIB-PCIIA Mode Selection Setting

2. Verify that switch 8 is pressed down on the side labeled 7210.

Note The National Instruments NI-488.2 software requires the board to be in 7210 mode.

= Not used to aelect the GPIB-PC
   or 7210/9914 mode

O
FF

7210
PCII

9914
PCIIA

U21 0

1
3

2
4

5
7

6
8

9
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Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCIIA Mode)
Change the switch settings to match the base I/O address assigned to your board. By default, the 
GPIB-PCII/IIA is configured to use base I/O address 2E1 hex when in GPIB-PCIIA mode.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

Table 7.  Base I/O Settings for the GPIB-PCII/IIA in PCIIA Mode

Base I/O 
Address Switch Setting

Base I/O 
Address Switch Setting

2E1
(Default)

22E1

42E1 62E1

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

View Parts 
Locator 

Diagram



HOME

TitleShort-Hidden -40 © National Instruments Corporation

GPIB-PCII/IIA Next
Step

Previous
Step

40

Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCIIA Mode)
Click the interrupt line (IRQ) setting assigned to your GPIB-PCII/IIA from the following list, and 
change the jumper and switch settings to match the interrupt line (IRQ) assigned to your board. 
By default, the GPIB-PCII/IIA is configured to use interrupt request line (IRQ) 7. 

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

2 3 4

5 6 7

Interrupt Disabled
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Table 8.  Interrupt Request Settings for GPIB-PCII/IIA in PCIIA Mode

Interrupt 
Line Switch Jumper

Interrupt 
Line Switch Jumper

2 3

4 5

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

The remaining steps in the installation and configuration process are the same for GPIB-PCII mode 
and GPIB-PCIIA mode. Click here to go to the Configure the GPIB-PCII/IIA DMA Channel section 
and continue configuring and installing your GPIB-PCII/IIA.

View Parts 
Locator 
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6 7

Interrupt 
Disabled

Table 8.  Interrupt Request Settings for GPIB-PCII/IIA in PCIIA Mode (Continued)

Interrupt 
Line Switch Jumper

Interrupt 
Line Switch Jumper

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I01

3
4

5

O
FF

I2
I1
I0O

FF

1
2

3
4

5
6

7
8

9

1  U 2  0

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

The remaining steps in the installation and configuration process are the same for GPIB-PCII mode 
and GPIB-PCIIA mode. Click here to go to the Configure the GPIB-PCII/IIA DMA Channel section 
and continue configuring and installing your GPIB-PCII/IIA.
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Locator 
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PC/104-GPIB

1. Configure the PC/104-GPIB Base I/O Address.

2. Configure the PC/104-GPIB Interrupt Line (IRQ).

3. Configure the PC/104-GPIB DMA Channel.

After you finish these steps, you are ready to Install the PC/104-GPIB.
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Figure 8.  PC/104-GPIB Parts Locator Diagram
View Parts Locator Diagram

1 Product Name and Assembly Number
2 Serial Number

3 Shield Ground
4 Interrupt Line (IRQ)

5 DMA Channel6Base I/O 
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®
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Configure the PC/104-GPIB Base I/O Address
Click the base I/O address assigned to your PC/104-GPIB from the following list, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your PC/104-GPIB, click here to Determine 
Assigned Resources.

100 200 300

120 220 320

140 240 340

160 260 360

180 280 380

1A0 2A0 3A0

1C0 2C0 (Default) 3C0

1E0 2E0 3E0
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Table 9.  Possible Base I/O Address Switch Settings for PC/104-GPIB

Base I/O
Address (hex)

Switch 
Settings

Base I/O
Address (hex)

Switch 
Settings

100 120

140 160

180 1A0

1C0 1E0

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5
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200 220

240 260

280 2A0

2C0
(Default)

2E0

Table 9.  Possible Base I/O Address Switch Settings for PC/104-GPIB (Continued)

Base I/O
Address (hex)

Switch 
Settings

Base I/O
Address (hex)

Switch 
Settings

A9O
F

F

A8

A7

A6

A5

A9O
F

F
A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5
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300 320

340 360

380 3A0

3C0 3E0

Table 9.  Possible Base I/O Address Switch Settings for PC/104-GPIB (Continued)

Base I/O
Address (hex)

Switch 
Settings

Base I/O
Address (hex)

Switch 
Settings

A9O
F

F

A8

A7

A6

A5

A9O
F

F
A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5
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Configure the PC/104-GPIB Interrupt Line (IRQ)
Change the jumper settings to match the interrupt line (IRQ) assigned to your board. However, if 
you are installing the PC/104-GPIB in an 8-bit stack, change the setting to the line in the range IRQ3 
to IRQ7 you chose on the Resources page of the PC/104-GPIB Properties dialog box. By default, 
the PC/104-GPIB is configured to use interrupt line (IRQ) 11.

If you do not know what resources were assigned to your PC/104-GPIB, click here to Determine 
Assigned Resources.

Table 10.  PC/104-GPIB Interrupt Line Configuration

Interrupt Lines Jumper Setting

Lines 10, 11, 12, 14, or 15
(IRQ 11 is shown)

Lines 3, 4, 5, 6, 7, or 9
(IRQ 5 is shown)

No IRQ

IR
Q

 1
0

IR
Q

 1
1

IR
Q

 1
2

IR
Q

 1
4

IR
Q

 1
5

W1

W3

IR
Q

 9

IR
Q

 7

IR
Q

 6

IR
Q

 5

IR
Q

 4

IR
Q

 3

IR
Q

9

IR
Q

7

IR
Q

6

IR
Q

5

IR
Q

4

IR
Q

3
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Configure the PC/104-GPIB DMA Channel
Change the jumper settings to match the DMA channel assigned to your board, or to no DMA if 
you are installing the PC/104-GPIB in an 8-bit stack. You must set both the DMA Acknowledge and 
DMA Request lines. By default, the PC/104-GPIB is configured to use DMA channel 5.

If your operating system is unable to assign a DMA resource to the PC/104-GPIB, or if you are 
installing it in an 8-bit stack, you can configure DMA to none and still use the NI-488.2 software.

If you do not know what resources were assigned to your PC/104-GPIB, click here to Determine 
Assigned Resources. 

Table 11.  PC/104-GPIB DMA Channel Settings

DMA Channel DMA Jumpers

5, 6, or 7
(DMA 5 is shown)

No DMA

D
R

Q
7

D
R

Q
5

D
A

C
K

5

D
R

Q
6

D
A

C
K

6

D
A

C
K

7

W2

D
R

Q
7

D
R

Q
5

D
A

C
K

5

D
R

Q
6

D
A

C
K

6

D
A

C
K

7

W2
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Set the PC/104-GPIB Shield Ground Configuration
The PC/104-GPIB is set at the factory with the jumper in place to connect the logic ground of the 
PC/104-GPIB to its shield ground. This configuration minimizes EMI emissions.

Note The PC/104-GPIB was tested for compliance with FCC and CE standards with the shield ground 
connected to logic ground. Removing the jumper might cause EMI emissions to exceed any or all 
of the applicable standards.

Most users do not need to change the shield ground configuration. If you need to disconnect the 
logic ground from shield ground, complete the following steps:

1. Locate the shield ground jumper W5 on the PC/104-GPIB. (View the PC/104-GPIB Parts Locator 
Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in Figure 9.

Figure 9.  PC/104-GPIB Ground Configuration Jumper Settings

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W5

W5
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Install the PC/104-GPIB
PRINT THIS TOPIC! 
Your computer needs to be off while you install your PC/104-GPIB. To print this topic, select 
File»Print, select the Pages radio button, and print pages 52–54.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

The PC/104-GPIB is available in two versions: stackthrough 16-bit and stackthrough 8-bit. 16-bit 
modules have two PC/104 connectors and 8-bit modules have one PC/104 connector. Verify that 
you have the correct version for your system.

Complete the following steps to install the PC/104-GPIB. In this section, the term parent module 
generically refers to either the parent system or the adjacent PC/104 module you stack the 
PC/104-GPIB onto.

1. Shut down Windows and power off your computer. Keep the computer plugged in so that it 
remains grounded while you install the PC/104-GPIB.

2. Mount the provided standoffs to the parent module before installing the PC/104-GPIB. 
You might need to install the provided hex nuts on the bottom side of the parent module to 
secure the standoffs in place. Notice that the parent module might have only two mounting 
holes for the standoffs instead of four; in this case, you need only two standoffs. 

3. Plug the PC/104-GPIB into the parent module. The PC/104 header is keyed so that it fits in only 
one direction. Do not force the PC/104 connector into place. 

After the PC/104-GPIB has been plugged in, ensure proper contact by gently pressing down 
at the PC/104 connector region of the PC/104-GPIB until the module is level with respect to 
the parent module. 

4. Fasten the PC/104-GPIB to the standoffs with the provided 4-40 screws. Refer to Figure 10 to 
view how to install the board.
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Figure 10.  Installing the PC/104-GPIB

1 PC/104-GPIB
2 GPIB Connection

3 GPIB Ribbon Cable
4 Screw

5 Standoff
6 Parent Module

7 PC/104 Connector
8 PC/104 Header
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5. Plug the GPIB ribbon cable into the GPIB connection on the PC/104-GPIB. The GPIB connection 
is keyed so that it fits in only one direction. Do not force the GPIB ribbon cable connector into 
place. The GPIB ribbon cable is 20 in. long and terminated with a panel-mount GPIB connector 
that can be mounted for easy access in your system.

Note If you plan to perform HS488 high-speed protocol transfers, you must configure the NI-488.2 
software for the amount of GPIB cable length in your system. You must add the 20 in. GPIB ribbon 
cable to your total GPIB cable length.

6. Power on your system and start Windows.
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NEC-GPIB/TNT

Configure the NEC-GPIB/TNT Base I/O Address.
After you finish configuration, you are ready to Install the NEC-GPIB/TNT.
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Figure 11.  NEC-GPIB/TNT Parts Locator Diagram
View Parts Locator Diagram

1 Product Name and Assembly Number
2 Serial Number

3 Base I/O Address
4 Address Decode

5 Shield Ground
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4

3

5
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Configure the NEC-GPIB/TNT Base I/O Address
Click the base I/O address assigned to your NEC-GPIB/TNT from the following list, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your NEC-GPIB/TNT, click here to Determine 
Assigned Resources.

1D0 2D0

3D0 4D0

5D0 6D0

7D0 (Default)
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Table 12.  Possible Base I/O Address Switch Settings for NEC-GPIB/TNT

Base I/O
Address 

(hex) Switch Settings

Base I/O
Address 

(hex) Switch Settings

1D0 2D0

3D0 4D0

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit
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5D0 6D0

7D0
(Default)

Table 12.  Possible Base I/O Address Switch Settings for NEC-GPIB/TNT (Continued)

Base I/O
Address 

(hex) Switch Settings

Base I/O
Address 

(hex) Switch Settings

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit

1
OFF

0
ON

O
F

F

1
2

3
4

5
6

7
8

9
10

W2

16 bit 12 bit
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Set the NEC-GPIB/TNT Shield Ground Configuration
The NEC-GPIB/TNT is set at the factory with the jumper in place to connect the logic ground of the 
NEC-GPIB/TNT to its shield ground. This configuration minimizes EMI emissions.

Note The NEC-GPIB/TNT was tested for compliance with FCC standards with the shield ground 
connected to logic ground. Removing the jumper might cause EMI emissions to exceed any or all 
of the applicable standards.

Most users do not need to change the shield ground configuration. If you need to disconnect the 
logic ground from shield ground, complete the following steps:

1. Locate the shield ground jumper W1 on the NEC-GPIB/TNT. (View the NEC-GPIB/TNT Parts 
Locator Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in Figure 12.

Figure 12.  NEC-GPIB/TNT Ground Configuration Jumper Settings

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W1

W1
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Install the NEC-GPIB/TNT
PRINT THIS TOPIC! 
Your computer needs to be off while you install your NEC-GPIB/TNT. To print this topic, select 
File»Print, select the Pages radio button, and print page 61.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

Complete the following steps to install the NEC-GPIB/TNT.

1. Make sure that your computer is powered off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Find an unused expansion slot in your computer.

3. Remove the corresponding slot cover on the back panel of the computer.

4. Insert the NEC-GPIB/TNT into the slot. It might be a tight fit, but do not force the board into 
place.

5. Screw the mounting bracket of the NEC-GPIB/TNT to the back panel of the computer.

6. Power on your computer and start Windows. 

The NEC-GPIB/TNT hardware installation is now complete.
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Determine Assigned Resources
Before you configure and install your board, you need to know the resources assigned to your 
hardware. 

Windows XP/2000/Me/98
The Add GPIB Hardware Wizard automatically opens this PDF file after it assigns resources to 
your GPIB hardware. The Add GPIB Hardware Wizard window is probably open on your desktop. 
Switch to that window to view the resources assigned to your GPIB hardware.

If you do not have the Add GPIB Hardware Wizard running, launch it by selecting 
Start»Programs»National Instruments»NI-488.2»Add GPIB Hardware. Complete the steps 
until it displays the list of resources assigned to your GPIB hardware.

Windows NT
Windows NT is not a true Plug and Play operating system; therefore, it does not have an Add GPIB 
Hardware Wizard concept. When you install new GPIB hardware, try to use the default hardware 
settings. If these settings fail due to a resource conflict, use the Start»Programs»Administrative 
Tools»Windows NT Diagnostics utility. Use the Resources tab of this utility to get a list of 
resources that are known to be in use. This list is not necessarily complete, so remember that the 
resources not listed only might be available. The only way to know if a resource is available is to 
configure your hardware to use it, try it, and see if the NI-488.2 Troubleshooting Wizard passes.

After you select your resources, configure and install your GPIB hardware using the information in 
this PDF file. Then, use the GPIB Configuration Utility to communicate the resources assigned to 
your GPIB hardware. Run the NI-488.2 Getting Started Wizard for instructions on using the GPIB 
Configuration Utility.
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AT-GPIB/TNT (PnP) and AT-GPIB/TNT+
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 63–64.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

1. Make sure that your computer is powered off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Remove the top cover (or other access panels) to gain access to the computer expansion slots.

3. Find an unused expansion slot in your computer. The AT-GPIB/TNT (PnP) board requires a 
16-bit ISA expansion slot.

4. Remove the corresponding slot cover on the back panel of the computer.

5. Insert the GPIB board into the slot with the GPIB connector sticking out of the opening on the 
back panel, as shown in Figure 13. It might be a tight fit, but do not force the board into place.
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Figure 13.  Installing the AT-GPIB/TNT (PnP) or AT-GPIB/TNT+

6. Screw the mounting bracket of the GPIB board to the back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot) and power on your computer.

The GPIB hardware installation is now complete.
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GPIB-1394
1. Screw the DC power connector of the DC power supply into the DC power connector on the 

back panel of the GPIB-1394.

2. Plug the DC power supply into an AC outlet.

Figure 14.  Installing the GPIB-1394

3. Connect the 1394 cable to any available 1394 connector on your PC.

4. Connect the 1394 cable to any available 1394 connector on your GPIB-1394.

5. Turn on the GPIB-1394 with the power switch on its front panel. The GPIB-1394 is now 
powered by the DC power supply.

If your computer is already running, the operating system automatically detects the GPIB 
hardware. Otherwise, the GPIB hardware is detected when you start your computer.

The GPIB-1394 installation is now complete.

1 PC
2 GPIB 1394

3 1394 Connectors
4 GPIB Cable

5 DC Power Supply
6 DC Power Connector

7 1394 Cable
8 1394 Connector
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GPIB-USB Interfaces
To install the GPIB-USB interface, connect the USB connector from the GPIB-USB interface to an 
available USB port on your computer. The GPIB-USB interface connects directly to most GPIB 
devices without requiring a GPIB cable. If your computer is already running, the operating system 
automatically detects the GPIB interface. Otherwise, the GPIB interface is detected when you start 
your computer.

Figure 15.  Installing the GPIB-USB Interface

1 PC 2 GPIB-USB Interface 3 To GPIB Devices 4 USB Connector
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NEC-GPIB/TNT (PnP)
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print page 67.

Complete the following steps to install the NEC-GPIB/TNT (PnP).

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

1. Make sure that your computer is powered off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Find an unused expansion slot in your computer.

3. Remove the corresponding slot cover on the back panel of the computer.

4. Insert the NEC-GPIB/TNT (PnP) into the slot. It might be a tight fit, but do not force the board 
into place.

5. Screw the mounting bracket of the NEC-GPIB/TNT (PnP) to the back panel of the computer.

6. Power on your computer and start Windows.

The NEC-GPIB/TNT (PnP) hardware installation is now complete.
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PCI Express™ Interface for GPIB, PCI-GPIB, PCI-GPIB+, 
PCI-GPIB/LP, PCI-8212, and PCI-8232

PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 68–69.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

1. Make sure that your computer is powered off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Remove the top cover (or other access panels) to gain access to the computer expansion slots.

3. Find an unused expansion slot in your computer. Your PCI card can be plugged into either a 
3.3 V or 5 V, 32- or 64-bit PCI slot. Your PCI Express™ Interface for GPIB can be plugged into a 
x1, x4, x8, or x16 PCI Express™ Interface for GPIB slot.

4. Remove the corresponding slot cover on the back panel of the computer.

5. Insert the GPIB board into the slot with the GPIB connector sticking out of the opening on the 
back panel, as shown in Figure 16. It might be a tight fit, but do not force the board into place. 
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Figure 16.  Installing Your PCI Card

6. Screw the mounting bracket of the GPIB board to the back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Power on your computer.

The GPIB hardware installation is now complete.

1 PCI Express™ Interface for GPIB Board
2 PCI Express™ Interface for GPIB Slot
3 Computer

1 PCI Board
2 PCI Slot

3  Computer
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PCMCIA-GPIB and PCMCIA-GPIB+

Windows XP/2000/Me/98, Macintosh
1. Reboot the computer. 

2. If the PCMCIA-GPIB is not already inserted, insert it into a free PC Card (PCMCIA) socket. 
The card has no jumpers or switches to set, and you do not need to power down the system 
when you insert it. 

Windows NT (PCMCIA-GPIB only)
1. Power off your computer.

2. Insert the PCMCIA-GPIB into a free PC Card (PCMCIA) socket. The card has no jumpers or 
switches to set.

3. Power on your computer and start Windows.
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Figure 17 shows how to insert the PCMCIA-GPIB and how to connect the cable.

Figure 17.  Inserting the PCMCIA-GPIB

The hardware installation is now complete.

1 Portable Computer 2 PCMCIA Socket 3 PCMCIA-GPIB Cable

INSERT CARD

1

2

3
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PMC-GPIB
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 72–74.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid 
electrostatic damage when you handle the board, touch the antistatic plastic package to a metal 
part of your system chassis before removing the board from the package.

Complete the following steps to install your PMC-GPIB.

1. Power off your system. 

2. Find an unused PMC slot in your system. You may need to remove the host from the system to 
access the PMC slot.

3. Remove the corresponding slot filler panel from the host.

4. Insert the PMC-GPIB into the slot as shown in Figure 18. It might be a tight fit, but do not force 
the board into place.
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Figure 18.  Installing the PMC-GPIB

1 Host Face Plate
2 3.3 V Keying Hole

3 5 V Keying Hole
4 PMC-GPIB Board

5 Mounting Screws

5

1

2

3 4



HOME

TitleShort-Hidden -74 © National Instruments Corporation

PMC-GPIB Previous
Step

74

5. Use the mounting hardware provided to fasten the PMC-GPIB to the host.

6. Reinstall the host, if you removed it to install the PMC-GPIB.

7. Power on your system and start Windows. 

The PMC-GPIB hardware installation is now complete.
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PXI-GPIB, PXI-8212, and PXI-8232
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 75–77.

Caution Electrostatic discharge can damage several components on your GPIB board. To avoid 
electrostatic damage when you handle the board, touch the antistatic plastic package to a metal 
part of your system chassis before removing the board from the package.

Complete the following steps to install your PXI card:

1. Make sure that your PXI or CompactPCI chassis is powered off. Keep the PXI or CompactPCI 
chassis plugged in so that it remains grounded while you install your PXI card.

2. Choose an unused PXI or CompactPCI 5 V peripheral slot. For maximum performance, your PXI 
card has an onboard DMA controller that can only be used if the board is installed in a slot that 
supports bus arbitration, or bus master cards. National Instruments recommends installing 
your PXI card in such a slot. If you install the board in a non-master slot, you must disable your 
PXI cards onboard DMA controller using the board-level call ibdma. Refer to the NI-488.2 
Online Help for a complete description of ibdma.

3. Remove the filler panel for the peripheral slot you have chosen.

4. Touch a metal part on your chassis to discharge any static electricity that might be on your 
clothes or body.

5. Insert your PXI card into the selected 5 V slot. Use the injector/ejector handle to fully inject the 
device into place. Figure 19 shows how to install your PXI card into a PXI or CompactPCI 
chassis.
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Figure 19.  Installing Your PXI Card
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6. Screw the front panel of the PXI card to the front panel mounting rail of the PXI or CompactPCI 
chassis.

7. Power on your PXI or CompactPCI chassis and start Windows.

The PXI card installation is now complete. 
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GPIB-ENET/100

GPIB-ENET/100 Installation

Startup

Ethernet Configuration

Firmware Update

PWR/RDY LED Signaling

CFG RESET Switch
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GPIB-ENET/100 Installation
1. Connect one end of your Ethernet cable to your GPIB-ENET/100. Connect the other end of the 

Ethernet cable to your Ethernet network.

2. Connect one end of the power cord to the power supply. Screw the power connector on the 
other end of the power supply onto the power jack of the GPIB-ENET/100.

3. Plug the other end of the power cord into an AC outlet.

Figure 20.  Installing the GPIB-ENET/100

1 Front Panel LEDs
2 GPIB Cable

3 Power Cord
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7 Ethernet Cable
8 To Ethernet Network

 NATIONAL 

INSTRUMEN
TS

8

7 4
3

2

6

5

1



HOME

TitleShort-Hidden -80 © National Instruments Corporation

GPIB-ENET/100 Next
Step

Previous
Step

80

4. Refer to the Baseplate Identification Label and make a note of the serial number, Ethernet 
address, and default hostname. You will need this information when you run some of the 
utilities.

5. Contact your network administrator to determine whether your network supports DHCP or if 
you need to manually perform the Ethernet configuration to set up the network parameters. 
If your network uses DHCP, the network configuration is performed automatically at startup. 
A steady yellow PWR/RDY LED indicates the GPIB-ENET/100 passed its self-tests and acquired 
its IP address. The unit is now ready to operate. You may need to run software configuration 
and verification utilities at this time.

6. Connect the GPIB cable to the GPIB-ENET/100. Connect the other end to your GPIB instrument.
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Baseplate Identification Label
When you configure the GPIB-ENET/100 for use on your network, you will need to differentiate it 
from other network devices. Every GPIB-ENET/100 has a unique serial number, Ethernet address, 
and default hostname. You can find this information on the baseplate identification label on the 
GPIB-ENET/100.

Note The Ethernet address is not the IP address. All devices on an Ethernet network are assigned a 
unique physical address—the Ethernet address—so they can communicate with each other.

Figure 21.  GPIB-ENET/100 Baseplate Identification Label

You can use the NI Ethernet Device Configuration utility to change the hostname.

1 Serial Number 2 Ethernet Address 3 Default Hostname

N114 1

2

3
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Startup
Turn on the front-panel power switch. The PWR/RDY LED flickers orange rapidly while the 
GPIB-ENET/100 completes its power-on self-tests and attempts to acquire its network parameters. 
Each Ethernet and GPIB LED lights up as its functionality is tested.

By default, the GPIB-ENET/100 attempts its network configuration automatically through DHCP. 
The time required for assigning the IP address depends on your network and the configuration of 
your GPIB-ENET/100. Allow up to 90 seconds and observe the state of the PWR/RDY LED to 
determine the outcome of the self tests. One of the following should occur:

• A steady yellow PWR/RDY LED indicates the GPIB-ENET/100 passed its self tests and acquired 
its IP address. The unit is now ready to operate. When using DHCP, the GPIB-ENET/100 typically 
is ready to operate about 15 seconds after you power it on.

• If the PWR/RDY LED continues to flicker orange rapidly, the unit was unable to use DHCP to 
configure its network parameters. It is now in network configuration mode. Refer to Ethernet 
Configuration for information on configuring the network parameters manually. If this utility 
is successful, the PWR/RDY LED should become steady yellow.

• If the PWR/RDY LED blinks a slow red/yellow pattern, the GPIB-ENET/100 did not pass its self 
tests. Refer to PWR/RDY LED Signaling to interpret the flash pattern before calling National 
Instruments Technical Support.

• If the PWR/RDY LED is steady red, the GPIB-ENET/100 has an unrecoverable error. Contact 
National Instruments Technical Support.

Table 13, LED Descriptions, summarizes the functionality of all the front-panel LEDs on the 
GPIB-ENET/100.
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Table 13.  LED Descriptions

LED Description

PWR/RDY Flashes orange rapidly at start-up while performing self tests and 
when acquiring network parameters. A steady yellow state indicates 
the box is ready for operation. A distinct red/yellow flashing pattern 
indicates an error occurred.

LINK 10/100 Indicates the GPIB-ENET/100 detected a twisted pair (10Base-T or 
100Base-TX) link. The color indicates the connection speed. If yellow, 
the speed is 10 Mbits/s. If green, the speed is 100 Mbits/s.

TX Indicates the GPIB-ENET/100 is transmitting to the Ethernet 
network.

RX Indicates the GPIB-ENET/100 is receiving Ethernet network traffic.

TALK Indicates the GPIB-ENET/100 is configured as a GPIB Talker.

LISTEN Indicates the GPIB-ENET/100 is configured as a GPIB Listener.
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Ethernet Configuration
Use the NI Ethernet Device Configuration utility if you need to manually configure the network 
parameters of the GPIB-ENET/100. If your network uses DHCP, the network configuration is 
performed automatically at startup and you do not need to run this utility unless you want to 
change the hostname. Consult your network administrator if you do not know whether your 
network uses DHCP.

In addition to manually configuring the network parameters, you can use the NI Ethernet Device 
Configuration utility for any of the following purposes:

• Enable DHCP

• Verify or change the hostname

• Add or change a comment to help identify the device
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Using the NI Ethernet Device Configuration Utility
The GPIB-ENET/100 must be in network configuration mode—the PWR/RDY LED continuously 
flickers orange rapidly—before you can make changes to the network parameters. The 
GPIB-ENET/100 automatically enters network configuration mode if it is unable to obtain its 
network configuration through DHCP. During normal operation, you also can enter network 
configuration mode by pressing and holding the rear-panel CFG RESET switch for three seconds.

Run the NI Ethernet Device Configuration Utility. For Windows, select Start»Programs»National 
Instruments»NI-488.2»Explore GPIB to launch Measurement & Automation Explorer. Select 
Help»Help Topics»NI-488.2 to view the NI-488.2 online help. Search for the topic Set Network 
Settings for the GPIB-ENET/100 and click the link to launch the utility.

If you are using a Macintosh or UNIX platform, launch the utility from its installation location.

The NI Ethernet Device Configuration window displays a list of National Instruments Ethernet 
devices found on your subnet, sorted by model. You can identify your device by the Ethernet 
address or the serial number found on the GPIB-ENET/100 baseplate label. 

The listed devices can be in one of four possible states, as indicated in the IP address/hostname 
column:

• A hostname indicates the device has successfully been configured by DHCP.

• A numerical IP address indicates the device has successfully been configured with a static 
IP address.

• *Unconfigured* indicates the device is configured to use DHCP, but DHCP failed to attain 
network parameters.

• *Busy* indicates the device is configured to use DHCP and currently is attempting to acquire 
network parameters.
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View the properties for any of the following reasons:

• You need to configure an unconfigured IP address.

• You need to change the current network parameters.

• You previously used DHCP, but it is no longer available.

• You are using DHCP and need to change the hostname of the GPIB-ENET/100.

• The IP address/hostname column displays an exclamation point (!) next to your 
GPIB-ENET/100, indicating a configuration problem. Refer to Verifying the Hostname for help 
resolving this problem.

• You want to add or change a comment to help identify the device.

Refresh the list of Ethernet devices if you do not see your GPIB-ENET/100 in the list, or to discover 
a device that you recently added to the subnet.

Exit if you are finished using the NI Ethernet Device Configuration utility or if you are using DHCP 
and you do not need to change the hostname of the GPIB-ENET/100.
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Changing the Network Settings
Your GPIB-ENET/100 must be in network configuration mode before you can use the NI Ethernet 
Device Configuration utility to change its network settings. You also can Enter Network 
Configuration Mode during Normal Operation if the PWR/RDY LED is not currently flickering 
orange rapidly.

1. View the properties for your GPIB-ENET/100.

The current hostname is displayed. The hostname associates a name with a numerical IP 
address. Hostname is a required field.

The GPIB-ENET/100 attempts to use the hostname when registering with DHCP. Many DHCP 
servers have the ability to register the hostname and the assigned IP address. You then can 
reliably use the hostname to communicate with your GPIB-ENET/100 even if the numerical 
IP address changes.

However, some DHCP servers do not implement hostname registration. The GPIB-ENET/100 
requires Domain Name Server (DNS) registration when using DHCP. If your DHCP server does 
not support DNS registration, you must use static network parameters.

2. Select either Obtain an IP address automatically (DHCP) or Use the following IP settings.

a. If you select Obtain an IP address automatically (DHCP), you do not need to enter any 
network parameters unless you want to change the hostname of the Ethernet device.

b. If you select Use the following IP settings, enter the Static IP Parameters you have 
chosen for the host IP address, subnet mask, gateway IP, and DNS server IP. 

3. You can enter an optional comment to help you identify each device.

4. Confirm your changes and exit the NI Ethernet Device Configuration utility.

The GPIB-ENET/100 automatically reboots with the new configuration in effect.
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Static IP Parameters
If DHCP is not available, you must provide the GPIB-ENET/100 with several important network 
parameters.

• IP address—The unique, computer-readable address of a device on your network. An IP 
address typically is represented as four decimal numbers separated by periods (for example, 
130.164.54.215). Refer to the Choosing a Static IP Address section.

• Subnet mask—A code that helps the network device determine whether another device is 
on the same network or a different network.

• Gateway IP—The IP address of a device that acts as a gateway, which is a connection between 
two networks. If your network does not have a gateway, set this parameter to 0.0.0.0.

• DNS Server—The IP address of a network device that stores hostnames and translates them 
into IP addresses. If your network does not have a DNS server, set this parameter to 0.0.0.0.
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Choosing a Static IP Address

For a Network Administered by a Network Administrator
If you are adding the GPIB-ENET/100 to an existing Ethernet network, you must choose IP 
addresses carefully. Contact your network administrator to obtain an appropriate static IP address 
for your GPIB-ENET/100. Also have the network administrator assign the proper subnet mask, 
gateway, and DNS server addresses.

For a Network without a Network Administrator
If you are assembling your own small Ethernet network, you can choose your own IP addresses. 
The format of the IP addresses is determined by the subnet mask. You should use the same subnet 
mask as the computer you are using with your GPIB-ENET/100. If your subnet mask is 
255.255.255.0, the first three numbers in every IP address on the network must be the same. 
If your subnet mask is 255.255.0.0, only the first two numbers in the IP addresses on the network 
must match.

For either subnet mask, numbers between 1 and 254 are valid choices for the last number of 
the IP address. Numbers between 0 and 255 are valid for the third number of the IP address, 
but this number must be the same as other devices on your network if your subnet mask is 
255.255.255.0.

If you are setting up your own network, you probably do not have a gateway or DNS server, 
so you should set these values to 0.0.0.0.
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Verifying the Hostname
The NI Ethernet Device Configuration utility automatically verifies that the hostname for each 
DHCP-enabled device matches the DNS entry for the assigned IP address. This verification process 
automatically occurs when you either run the utility or refresh the list of devices. The utility alerts 
you if it detects a problem with the network settings.

To correct the problem with the hostname, complete the following steps:

1. Locate the device that has a problem. This is indicated by an exclamation point (!) on the 
device icon.

2. View the properties for the device. The utility displays four options for resolving the 
verification error. Select the one that best fits your situation.

• Change the device’s hostname to match the DNS entry—Use this option if you want to 
accept the hostname assigned by the DHCP server, or if you cannot contact the network 
administrator to change the DNS entry.

• Use static network parameters instead of DHCP—Use this option if you cannot use the 
hostname assigned by the DHCP server. Contact your network administrator to obtain a 
valid IP address, subnet, and gateway. This option disables DHCP on the device.

• Edit the current hostname—Use this option to change the hostname to a name other 
than either the configured hostname or the name assigned by the DHCP server. Contact 
your network administrator to obtain a valid name.

• Keep the existing hostname—Use this option if you wish to keep the previously 
assigned hostname. If you select this option, contact your network administrator to 
change the DNS entry.

3. Confirm the network parameter settings. The device reboots with the new settings in effect.

4. After the device reboots, refresh the list of devices to verify that the hostname is now valid.

5. Exit when you are finished using the NI Ethernet Device Configuration utility.
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Firmware Update
The GPIB-ENET/100 software includes a firmware update utility you can use to access new features 
that may be added to the GPIB-ENET/100 in the future. You must update the firmware to take 
advantage of any new features.

The GPIB-ENET/100 always ships with the most recent firmware. You do not need to run the 
firmware update utility on a new product. You can obtain the latest upgrade at the following path:

ftp://ftp.ni.com/support/gpib/firmware/GPIBENET100/

You need to know either the IP address or hostname of your GPIB-ENET/100 before you run the 
NI Ethernet Device Firmware Update utility. If you do not remember this information, first run 
the NI Ethernet Device Configuration utility.

Caution Do not power-off the GPIB-ENET/100 or disconnect the power supply while running the 
NI Ethernet Device Firmware Update utility. Doing so will damage the unit. The GPIB-ENET/100 
reboots automatically when the update completes.

Note The NI Ethernet Device Firmware Update utility cannot update the firmware while any network 
connections are active. Close any open connections before you attempt a firmware update. Hosts 
cannot connect to the GPIB-ENET/100 while it is updating the firmware.

1. In Windows, run the Measurement & Automation Explorer. Right-click on any GPIB-ENET/100 
interface and select Firmware Update from the drop-down menu. For Macintosh or UNIX 
platforms, launch the utility from its installation location.

2. Specify the hostname or IP address of the GPIB-ENET/100 and enter the full path of the binary 
file where the firmware image is located.

3. The NI Ethernet Device Firmware Update utility communicates with the specified 
GPIB-ENET/100 to verify the box has no open network connections and determine the current 
version of the firmware in the unit.
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4. When prompted, confirm the change you are about to perform. The update utility transfers 
the firmware image to your GPIB-ENET/100 and displays the status of the update, including 
whether the firmware update completed successfully or failed. The GPIB-ENET/100 
automatically reboots with the new firmware in effect.

5. Exit the NI Ethernet Device Firmware Update utility.
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PWR/RDY LED Signaling
The PWR/RDY LED blinks slowly in a distinct red/yellow pattern to alert you of internal errors. Use 
this section to interpret and record the pattern that the PWR/RDY LED flashes, and then contact 
National Instruments.

Note By recording the PWR/RDY LED status messages before calling National Instruments, you can save 
yourself time, and the Product Support Department can answer your questions more accurately 
and efficiently. Do not switch off power to your GPIB-ENET/100 before recording the flashing 
PWR/RDY LED pattern.

PWR/RDY LED signaling can report up to 81 different errors. The errors are numbered from 
11 to 99 and are reported through sequences of PWR/RDY LED flashes.

Note There is no zero in any error message. This means that error message numbers 0–10, 20, 30, 40, 50, 
60, 70, 80, and 90 are not possible.

Step 1. Count the Long Flashes
A three-second interval, during which the PWR/RDY LED is yellow, separates each repetition of 
the sequence. The sequence begins with a series of long one-second flashes—that is, one second 
red, one second yellow. These long flashes represent the digit in the tens column. There can be 
one to nine long flashes, which represent digits 1 through 9. For example, one long flash 
represents the digit 1 in the tens column, and nine long flashes represent the digit 9 in the tens 
column.
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Step 2. Count the Short Flashes
The long flashes are followed by shorter flashes; each short flash lasts about one-fifth of a 
second—that is, one-fifth of a second red, one-fifth of a second yellow. These short flashes 
represent the digit in the ones column. Again, there can be one to nine flashes, which represent 
the digits 1 through 9. For example, one short flash represents the digit 1 in the ones column, 
and nine short flashes represent the digit 9 in the ones column.

Using this method, the PWR/RDY LED flashes the following sequence to represent status 
message 11:

<three seconds yellow> <one long red flash> <one short red flash> 
<three seconds yellow>…

The PWR/RDY LED flashes the following sequence to represent status message 31:

<three seconds yellow> <three long red flashes> <one short red flash> 
<three seconds yellow>…

Step 3. Record Your Status Code Number
When you have computed your error message number, write it down and also note the 
ON/OFF state of the LINK, TX, and RX LEDs. Have this information available when calling 
National Instruments.
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CFG RESET Switch
The Configuration Reset (CFG RESET) switch is a recessed switch located beside the ENET 
connector on the rear panel.

You can use this switch to either reset the unit to its default network characteristics or place the 
GPIB-ENET/100 in network configuration mode.

Reset the Default Network Characteristics at Startup
If you want to reset the unit to its default network characteristics, you can use the CFG RESET 
switch at power-on. By pressing and holding the CFG RESET switch while you power on the 
GPIB-ENET/100, the network parameters revert to the default settings as defined on the baseplate 
label.

You must press and hold the switch for three seconds. If you release the switch prior to three 
seconds, no change occurs to the network configuration, and the GPIB-ENET/100 continues to 
boot normally.

Observe the PWR/RDY LED as it goes through the following changes during these three seconds.

1. The LED begins slowly alternating between red and yellow.

2. The alternating pattern increases in tempo.

3. At three seconds, the PWR/RDY LED becomes steady red. This indicates the network 
configuration will be set to the factory default settings.

4. When you release the CFG RESET switch, the box continues to boot as normal, and the 
PWR/RDY LED indicates the boot process as described in Table 13, LED Descriptions.
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Enter Network Configuration Mode during Normal Operation
While the GPIB-ENET/100 is operational, as indicated by a steady yellow PWR/RDY LED, you can 
use the CFG RESET switch to place the box into network configuration mode. You then can use the 
NI Ethernet Device Configuration utility.

Because you cannot change the network parameters unless you deliberately place the 
GPIB-ENET/100 into network configuration mode, the parameters are protected while in normal 
operation. Hosts cannot connect to the GPIB-ENET/100 while it is in network configuration mode.

Note Pressing the CFG RESET switch has no effect if hosts are currently connected.

Close all connections, then press and hold the CFG RESET switch for three seconds. If you release 
the switch prior to three seconds, the GPIB-ENET/100 continues to operate normally.

The PWR/RDY LED goes through the following changes during these three seconds.

1. The LED begins slowly alternating between red and yellow.

2. The alternating pattern increases in tempo.

3. At three seconds, the PWR/RDY LED becomes steady red. This indicates the GPIB-ENET/100 is 
ready to enter network configuration mode.

4. Now release the CFG RESET switch. The PWR/RDY LED alternates rapidly between red and 
yellow to indicate the GPIB-ENET/100 is now in network configuration mode.

This mode remains in effect until you switch off the GPIB-ENET/100 or you use the NI Ethernet 
Device Configuration utility to change its network characteristics. The GPIB-ENET/100 
automatically reboots when you exit the utility.
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Specifications/Compliance

Safety
This product is designed to meet the requirements of the following standards of safety for 
information technology equipment: 

• IEC 60950-1, EN 60950-1

• UL 60950-1

• CAN/CSA C22.2 No. 60950-1

Note For UL and other safety certifications, refer to the product label, or visit ni.com/hardref.nsf, 
search by model number or product line, and click the appropriate link in the Certification column.

Electromagnetic Compatibility
• Emissions: EN 55011 Class A at 10 m. FCC Part 15A above 1 GHz

• Immunity: EN 61326:1997 + A2:2001, Table 1

• CE, C-Tick, and FCC Part 15 (Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European Directives, as amended for 
CE marking, as follows:

• Low-Voltage Directive (safety): 73/23/EEC

• Electromagnetic Compatibility Directive (EMC): 89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory 
compliance information. To obtain the DoC for this product, visit ni.com/hardref.nsf, search 
by model number or product line, and click the appropriate link in the Certification column.
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Technical Support Resources

NI Web Support
National Instruments Web support is your first stop for help in solving installation, configuration, 
and application problems and questions. Online problem-solving and diagnostic resources 
include frequently asked questions, knowledge bases, product-specific troubleshooting wizards, 
manuals, drivers, software updates, and more. Web support is available through the Technical 
Support section of ni.com.

Worldwide Support
National Instruments corporate headquarters is located at 11500 North Mopac Expressway, 
Austin, Texas, 78759-3504. National Instruments also has offices located around the world to help 
address your support needs. You can access our branch office Web sites from the Worldwide 
Offices section of ni.com. Branch office Web sites provide up-to-date contact information, 
support phone numbers, email addresses, and current events. 

If you have searched the technical support resources on our Web site and still cannot find the 
answers you need, contact your local office or National Instruments corporate. For telephone 
support in the United States, dial 512 795 8248. For telephone support outside the United States, 
contact your local branch office: 

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20, 
Brazil 55 11 3262 3599, Canada (Calgary) 403 274 9391, Canada (Ottawa) 613 233 5949, 
Canada (Québec) 450 510 3055, Canada (Toronto) 905 785 0085, 
Canada (Vancouver) 514 685 7530, China 86 21 6555 7838, Czech Republic 420 224 235 774, 
Denmark 45 45 76 26 00, Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24, 
Germany 49 0 89 741 31 30, Greece 30 2 10 42 96 427, India 91 80 51190000, 
Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 
Malaysia 603 9131 0918, Mexico 001 800 010 0793, Netherlands 31 0 348 433 466, 
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New Zealand 0800 553 322, Norway 47 0 66 90 76 60, Poland 48 22 3390150, 
Portugal 351 210 311 210, Russia 7 095 783 68 51, Singapore 65 6226 5886, 
Slovenia 386 3 425 4200, South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 
Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, Taiwan 886 2 2528 7227, 
Thailand 662 992 7519, United Kingdom 44 0 1635 523545
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Important Information

Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be 
defective during the warranty period. This warranty includes parts and labor. 
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to 
defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. 
National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National 
Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the 
software shall be uninterrupted or error free.
A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package 
before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner 
parts which are covered by warranty.
National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are 
suspected. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information 
contained in it.
EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE 
AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will apply 
regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be 
brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to 
causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service failures 
caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of 
the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright
© 2001–2004 National Instruments Corporation. All rights reserved.
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including 
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent 
of National Instruments Corporation.

Trademarks
National Instruments™, NI™, ni.com™, and NI-488.2™ are trademarks of National Instruments Corporation.
Product and company names mentioned herein are trademarks or trade names of their respective companies.
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Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, 
the patents.txt file on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE 
FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE 
FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.
(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY 
ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE 
MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO 
DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR 
FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR 
SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS 
SUCH AS THESE ARE HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT 
SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE 
USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT 
NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM 
NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS 
PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, 
THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL 
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, 
INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.


